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  Evaluating Reflection for Secure IT Web Edition 

 

Evaluating Reflection for Secure IT Web Edition 

Reflection for Secure IT Web Edition provides a secure way to manage file exchange with users 
outside your network. Secure authentication and encryption are used for all connections. In this 
evaluation, you'll use three systems: a user workstation, the Web Edition server and a file 
server. 

     

 User workstation 

Users log into the web-based Reflection for Secure IT Transfer Client and can upload or 
download documents using an easy drag-and-drop interface.  

 Web Edition server 

For this evaluation, the Web Edition server runs all three Web Edition services: 

• Reflection for Secure IT Web Transfer Server 
Authenticates Web Edition users and is the application server for the Transfer Client.  

• Reflection for Secure IT Server for Windows 
A Secure Shell server that manages secure file transfers.  

• User Manager 
A web-based tool for configuring which users can log into the Web Edition Transfer 
Client. You can use it to provide access to external users (such as customers or 
business partners) and to allow access to remote users (users with domain accounts 
working outside your firewall). 

 File server 

This server is the ultimate destination for uploaded files and the source for downloads. 
Users have access only to the directories you specify, and have no knowledge of the host 
name or the actual directory names on this server.  
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Set Up for your Evaluation 

For this evaluation, you'll use three systems:  

 The Reflection for Secure IT Web Edition server 

 A file server  

 A user workstation 
  

Note: For detailed system requirements, see the Reflection for Secure IT Web Edition 
Administrator's Guide (http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-
edition/rsit_web_edition_admin_guide.pdf). 

To install an evaluation copy of Reflection for Secure IT Web Edition on 
the Web Edition server 

1 Log in as an administrator on the Windows Server that you are using as your Web Edition 
server. 

2 Go to the Reflection for Secure IT Web Edition evaluation request page 
(http://www.attachmate.com/Evals/managed-file-transfer/rsit/rsweb/eval-form.htm). Enter 
the requested user information, and click Submit. This sends an email message with 
download instructions to the address you provided. 

3 Open your Attachmate Product Evaluation email message and click the download link. This 
link takes you to a list of available downloads, including both Reflection for Secure IT Web 
Edition and the free PKI Services Manager Add-On.  

Note: For this evaluation you do not need to install PKI Services Manager. 

4 Click the "rsit-webedition..." file that is appropriate for your Windows Server system.  

5 Review and agree to the Terms of Use, then click the download link and run the download 
package.  

6 Select a location for the installer files and click OK. The files are extracted to the specified 
location, and the Attachmate Setup program starts.  

7 Install using defaults. This installs all three Web Edition services. 

8 Select the option "Restart my computer for me."  

Note: A Windows restart is required to complete the installation of the Reflection for 
Secure IT server. It also starts the three services used by Reflection for Secure IT Web 
Edition.  

9 To confirm that the Reflection services are running, you can use the Windows Services 
console (Start > All Programs > Administrative Tools > Services). These three services 
should be present and running: Attachmate Reflection for Secure IT Server, Attachmate 
Reflection for Secure IT User Manager, and Attachmate Reflection for Secure IT Web 
Transfer. 

http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
http://www.attachmate.com/Evals/managed-file-transfer/rsit/rsweb/eval-form.htm�
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File server setup 

Your file server for this evaluation can be either (or both) of the following: 

 Any server available as a network share from the Web Edition system. 

 Any UNIX or Windows system running a Secure Shell (SSH) server that includes an SFTP 
server. If you don't already have a running server, you can install an evaluation copy of 
Reflection for Secure IT for UNIX (http://www.attachmate.com/Evals/managed-file-
transfer/rsit/rscu/eval-form.htm) or Windows (http://www.attachmate.com/Evals/managed-
file-transfer/rsit/rssw/eval-form.htm). 

User workstation setup 

The user workstation runs the Reflection for Secure IT Web Edition Transfer Client, which is a 
browser-based Java applet.  

 The workstation can be running any supported browser (Internet Explorer, Firefox, Chrome, 
or Apple Safari). JavaScript and cookies must be enabled. 

 The browser must have Java installed. Java is available free of charge from the Oracle 
website: http://java.com/en/download/ 

  

Note: If any of your test systems are outside your network firewall, refer to the topic "Ports and 
Firewall Configuration" in the the Reflection for Secure IT Web Edition Administrator's Guide 
(http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-
edition/rsit_web_edition_admin_guide.pdf). 

 

http://www.attachmate.com/Evals/managed-file-transfer/rsit/rscu/eval-form.htm�
http://www.attachmate.com/Evals/managed-file-transfer/rsit/rscu/eval-form.htm�
http://www.attachmate.com/Evals/managed-file-transfer/rsit/rssw/eval-form.htm�
http://www.attachmate.com/Evals/managed-file-transfer/rsit/rssw/eval-form.htm�
http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
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Configure and Test Transfers 

With your test systems configured, you're ready to start your evaluation.  

Test Cases 

Launch User Manager and Add a Test User 6 

Enable Web Edition User Access on the Reflection for Secure IT Server 7 

Transfer Files to the Web Edition Server 8 

Configure Web Edition to Act as a Gateway 10 

Transfer Files to the Back End File Server 12 

Set Transfer Permissions for a User Group 13 

 

 

Launch User Manager and Add a Test User 

In these procedures, you'll launch the Reflection for Secure IT Web Edition User Manager and 
add a test user. 

To launch the User Manager 

1 Start User Manager using either of the following methods: 

If you are logged into the Windows system that is running User Manager, you can start User 
Manager from the Windows Start Menu (Start > All Programs > Attachmate Reflection > 
Web Edition User Manager). 

-or- 

From a web browser enter the following URL replacing <user_manager_host> with the 
name or IP address of the host running the User Manager service. 

https://<user_manager_host>:9490 
  

Note: The User Manager runs in your default browser and you will see a certificate warning 
message before you see the login page. This warning shows up because the User Manager 
installs with a self-signed security certificate that is unknown to your browser. For initial 
testing purposes, you can ignore this warning and proceed with the connection (Internet 
Explorer or Chrome) or add an exception (Firefox). For more information, see Server 
Certificate Management in the Reflection for Secure IT Web Edition Administrator's Guide 
(http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-
edition/rsit_web_edition_admin_guide.pdf). 

http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
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2 For your initial login enter the following credentials.  

Username: admin 

Password: secret 

3 Immediately after your first log in, you'll be prompted to change the password for the 
admin account. Enter the current and new password and click Submit. 

Once you are successfully logged in, you should see the Users page. The initial view shows a 
single user - the admin account you used to log in. 

To add a test user 

1 From the Users page, click New. 

2 On the New User page: 

• Specify easy-to-remember values for UserID and password (or example test1/test1). 
You'll use these credentials for your test transfers. 

• Enter sample values for first name, last name and email address; these are required 
fields. 

• Leave group membership unchanged for this test user; group configuration is optional.  

3 Click Save. 

You'll be returned to the Users page and should see your new user added to the list. 

 

Enable Web Edition User Access on the Reflection 
for Secure IT Server 

To support file exchange using the Web Edition Transfer Client, you must configure the 
Reflection for Secure IT Server to allow access by Web Edition users.  

Before you begin 

 Select a Windows user account with rights to log onto the Web Edition server. This account 
will act as the "run as" account for Web Edition users. Web Edition users will run using the 
privileges of this user account. You'll need to know the username and password for this 
account. 

Note: To limit the access provided to Web Edition users, select a user account that is not a 
member of the Administrators group on this computer.  

To enable access by Web Edition users 

1 On the Web Edition server, start the Reflection for Secure IT Server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 On left panel of the Configuration tab, click Web Edition Users. 
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3 Enable Allow access to Web Edition users. 

4 Leave Restrict Web Edition users to file transfer sessions enabled. This setting helps 
ensure the security of your server. Disabling it creates a risk that a knowledgeable Web 
Edition user might use a terminal session to gain access to directories that you have not 
made accessible to SFTP users. Leaving this setting enabled is particularly important if 
your Web Edition user account has administrative privileges. 

5 For User Manager host, enter the name or IP address of the computer on which you 
installed the Reflection for Secure IT User Manager. If all Web Edition services are 
installed on the same computer, you can leave the default (localhost). Leave the default 
port value (9190). User Manager is configured by default to listen on this port. 

6 Click Select account. Click Add and enter the user name and password for the user under 
whose account Web Edition users will run. Click Test to confirm these credentials, then 
click OK to save this user account to the credential cache. 

7 In the Select Account dialog box, select the user account you just added and click OK to 
set this as the "run as" account for Web Edition users.  

8 Save your settings (File > Save Settings). 

9 Click Activate and verify. This triggers actions that ensure that the Reflection for Secure 
IT Server can establish a secure connection with the User Manager server. A dialog box 
display provides information about these steps. You will be prompted to accept the 
certificate presented by the User Manager server and to restart the Web Transfer service. 

10 (Recommended) To help ensure security on this system, disable port forwarding for all 
users. On the left panel of the Configuration tab, click Permissions. Under Tunneling, 
clear the two port forwarding options. 

  

 

Transfer Files to the Web Edition Server 

The two test transfers described below save the transferred file to the Web Edition server. 

Before you begin 

 Enable Web Edition user access on the Reflection for Secure IT Server (page 7). 

 Add a test user to the User Manager directory (page 6). You'll need to know this user's 
UserID and password. 

  

The first procedure transfers a document from one file location on the Web Edition server to 
another location on the same computer. This test scenario helps confirm that your setup is 
correct.  
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To test a transfer on the Web Edition server 

1 On the Web Edition server (the computer on which you installed the Secure Shell Server 
and Web Transfer feature), start the Transfer Client. (Start > All Programs > Attachmate 
Reflection > Web Edition Transfer Client.) 

Note: The Transfer Client runs in your default browser and you will see a certificate warning 
message before you see the login page. This warning shows up because the Web Transfer 
server installs with a self-signed security certificate that is unknown to your browser. For 
initial testing purposes, you can ignore this warning and subsequent warnings. Before you 
deploy to actual users, you will need to install a certificate from a well-known Certificate 
Authority (CA). Once you've configured the Reflection for Secure IT Web Transfer server to 
use the CA-signed certificate, users will be able to log in without seeing certificate 
warnings. For more information, see Server Certificate Management in the Reflection for 
Secure IT Web Edition Administrator's Guide (http://docs.attachmate.com/reflection/rsit-
ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf).  

2 Log in using the user ID and password of your test user. 

You'll see two additional messages: a certificate warning followed by a Java query. Both 
messages include an option to trust content from this publisher, and, if you select this 
option, the messages won't appear again. (The certificate warning won't appear at all once 
you've configured the server to use a CA-signed certificate.) 

3 The Transfer Client opens and connects to the running Reflection for Secure IT Server. 
Check to confirm that the status line in the lower left corner says "Connected to server." 

4 On the left side of the client, under Local files, browse to locate a document for a test 
transfer and drag this file to Server files. After the transfer is complete, you should see the 
transferred file in the Server files list. 

To locate the uploaded file on the Web Edition server 

 Find the file you just transferred on the Web Edition server in the following location: 

C:\Users\<run_as_user>\ReflectionWebEdition\Reflection\<web_edition_us
er> 

Where <run_as_user> is the user account you selected for Web Edition users to run 
under and <web_edition_user> is the userID of the test user you created in User 
Manager.  

  

The next transfer tests your ability to connect to the Transfer Client from a second computer 
and transfer a file from that computer to the Web Edition server. This test scenario confirms 
that your setup supports transfers from an external user's workstation.  
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To test a transfer from a second computer to the Web Edition server 

1 Open a browser on the computer you designated to act as a user workstation. 

2 Enter the following URL, replacing <web_edition_host> with the name or IP address of 
your Web Edition server. (This URL connects to the running Web Transfer Server). 

https://<web_edition_host>:9492 

3 Log in using the test user credentials and try a test transfer to the Web Edition Server. 

4 Find the uploaded file in the same location as in the previous test. 

 

Configure Web Edition to Act as a Gateway 

In this procedure, you'll configure the Web Edition server to act as a gateway. This enables 
transfers to go between the user workstation and a back end file server. Two procedures are 
given below. 

 Use the first procedure if the file server is available as a network share from the system 
running the Reflection for Secure IT Server. 

 Use the second procedure if the file server is an SFTP server. This might be a Windows 
system running Reflection for Secure IT Server for Window or a UNIX system running 
Reflection for Secure IT Server for UNIX. 

Configure the Reflection for Secure IT Server to connect to a network 
share 

1 On the Web Edition server, start the Reflection for Secure IT Server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 From the Configuration tab, click SFTP Directories in the left panel, then click Add. 

3 Enter a Virtual directory name (for example Test). This is the directory name that users 
will see when they run the Transfer Client. 

4 For Local or UNC directory, enter a UNC path that includes a server name and share. For 
example: 

\\server\share\public 

5 Click OK.  

6 In the SFTP Directories pane: 

• Set the User login directory to the virtual directory you just created, for example 
/Test. You'll see a warning message about changing the user key directory. Because 
Web Edition users do not use public key authentication, this is not a concern and you 
can click Yes to proceed.  

• Disable the default Home directory by clearing the Allow checkbox. 

7 Save your settings (File > Save Settings). 
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Configure the Reflection for Secure IT Server to connect 
to an SFTP server 

Before you begin 

 Confirm that a Secure Shell server is installed and running on the host that will serve as 
your file server, and that SFTP is enabled. (SFTP is enabled by default on Reflection for 
Secure IT servers.) 

 Confirm the DNS name or IP address for this host and know the port being used for Secure 
Shell connections (22 is the default). 

 Confirm the name and password of a valid account on this host. This user account will 
provide access to file system on the file server.  

  

To configure the connection to your SFTP server 

1 On the Web Edition server, start the Reflection for Secure IT Server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 From the Configuration tab, click SFTP Directories in the left panel, then click Add. 

3 Enter a Virtual directory name (for example Test). This is the directory name that users 
will see when they run the Transfer Client. 

4 Select Remote SFTP server. This opens the Remote SFTP Server Connection dialog box. 

Note: The "Remote SFTP server" you configure here is your back end file server. 

5 For Host, specify the name or IP address of the file server. The port for the connection to 
this server is set to 22 by default. Edit this if your Secure Shell server uses a different port. 

6 Under Host key, click Retrieve. Reflection for Secure IT connects to the Secure Shell 
server running on the file server, retrieves the host public key and displays a confirmation 
box. Click OK to accept this key and then close the Get Public Key dialog box. 

This key is used to confirm the host identity in subsequent connections, ensuring that 
documents are transferred to the correct host. 

7 Under Authentication, for Remote SFTP username and Password, enter the credentials 
of the user account that will provide access to the file system on the file server. 

8 Under Remote base directory, click Browse. This opens a browse dialog box showing 
directories available on this server. (The directories available for the transfer depend on 
this user's privileges and on how the SFTP server is configured.) Browse to select the 
directory you want to make available to your Web Edition users and click OK. The directory 
you select is entered in the Path field. 

9 Click Test Connection. You should see a message saying that the connection was 
successful. 

Note: The Test Connection dialog box includes a Details button. You can use the 
information provided to troubleshoot this connection. 
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10 Close the dialog boxes and return to the SFTP Directories pane. 

11 In the SFTP Directories pane: 

• Set the User login directory to the virtual directory you just created, for example 
/Test. You'll see a warning message about changing the user key directory. Because 
Web Edition users do not use public key authentication, this is not a concern and you 
can click Yes to proceed.  

• Disable the default Home directory by clearing checkbox in the Allow column. 

12 Save your settings (File > Save Settings). 

 

Transfer Files to the Back End File Server 

In this transfer, the document goes from the user workstation to your back end file server. 

 

Before you begin 

 Add a test user to the User Manager directory (page 6). You'll need to know this user's 
UserID and password. 

 Configure the Web Edition server to act as a gateway (page 10). 

To test a transfer from the user workstation to the file server 

1 Open a browser on the computer you designated to act as a user workstation. 

2 Enter the following URL, replacing <web_edition_host> with the name or IP address of 
your Web Edition server. (If you are already logged into the Transfer Client from a previous 
test, you can click Logout, and then log in again to test changes you've made on the Web 
Edition server.) 

https://<web_edition_host>:9492/ 

Note: The Transfer Client runs in your default browser and you will see a certificate warning 
message before you see the login page. This warning shows up because the Web Transfer 
server installs with a self-signed security certificate that is unknown to your browser. For 
initial testing purposes, you can ignore this warning and subsequent warnings. Before you 
deploy to actual users, you will need to install a certificate from a well-known Certificate 
Authority (CA). Once you've configured the Reflection for Secure IT Web Transfer server to 
use the CA-signed certificate, users will be able to log in without seeing certificate 
warnings. For more information, see Server Certificate Management in the Reflection for 
Secure IT Web Edition Administrator's Guide (http://docs.attachmate.com/reflection/rsit-
ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf). 

3 Log in using the username and password or your test user. 

http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�
http://docs.attachmate.com/reflection/rsit-ssh/8.1/web-edition/rsit_web_edition_admin_guide.pdf�


  Configure and Test Transfers 

13 
 

4 On the server side, you should see the files in the Test directory. (This is the Remote base 
directory you configured using the Remote SFTP Server Connection dialog box. The 
contents of this directory are displayed when the user connects because you set it as the 
User Log in directory in the SFTP Directories pane.) 

5 Test an upload to the server from the client computer.  

Confirm that your test file is on the server.  

 If you uploaded to a network share, confirm that the file is in the location you specified in 
the Accessible Directory Settings dialog box for Local or UNC directory. 

 If you uploaded to an SFTP server, log in to the SFTP server using the credentials you 
specified in the Remote SFTP Server Connection dialog box for Remote SFTP username 
and Password. Confirm that the file is in the location you specified under Remote base 
directory. 

 

Set Transfer Permissions for a User Group 

You can create customized transfer settings for individual users and for user groups. In this 
procedure you'll modify your Reflection for Secure IT Server settings to allow additional file 
access to members of the default "Administrators" group. 

Note: The Administrators group used here is the only default group in the User Manager, and 
the default admin user is a member of this group. This procedure uses this default group for 
testing. Once you finish testing, you'll want to configure group access using your own groups. 
These can be groups you create in User Manager, or groups in any LDAP directory you add to 
User Manager.  

Before you begin 

 Configure (page 10) and test (page 12) a transfer to a back end file server. 

Create a subconfiguration for members of the User Manager 
Administrators group 

1 On the Web Edition server, start the Reflection for Secure IT Server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 On the left panel, under Subconfiguration, click Group Configuration. 

3 Click Add. This opens the Group Configuration dialog box. 

4 Set Group type to Domain. 
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5 For Domain, enter Reflection.  

Use Reflection as the domain name for users or groups in the built-in User Manager 
directory. After you add additional LDAP directories to User Manager, you can also specify 
those domain names here. 

Note: If you use groups from an added LDAP server, confirm that the domain name you 
specify here exactly matches the domain name specified in User Manager. (In User 
Manager, go to LDAP Server, select your server, click Edit and check the value entered for 
Domain Name.) 

6 For Group, enter Administrators. 

7 In the left portion of the Group Configuration dialog box, click SFTP Directories. 

8 Click Add. This opens the Accessible Directory Settings dialog box. You'll use it to add 
access to a new folder that will be accessible to members of the Administrators group. 

• For Virtual Directory, enter AdminTest. 

• Click Browse and select any available local folder. It will be entered into Local or 
UNC directory. (For example C:\Samples.) 

• Click OK to close the Accessible Directory Settings dialog box and return to the group 
configuration SFTP Directories page. 

9 Use the drop-down list under User login directory to select  /. (You added a second 
accessible directory and this change means that users in this subconfiguration will see all 
available directories when they log in.) 

You'll see a warning about changing the user key directory. Because you are using 
password authentication for users, the warning doesn't apply to this test and you can click 
Yes to proceed. 

10 Click OK to close the Group Configuration dialog box. 

11 Save your settings (File > Save Settings). 

Connect to the Transfer Client as a member of the Administrators group 

1 From the user workstation, log on to the Transfer Client using the default admin account.  

2 The Server file list shows two directories. In the image below, the first directory 
(AdminTest) is the directory on the Web Edition server that is available only to members 
of the Administrators group. The second directory (Test) is the directory on the back end 
file server that is available to all users.   
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Note: If you've followed the procedures in this guide, these directories are on two different 
servers. The AdminTest directory is on the Web Edition server. The Test directory is on 
the back end file server. These actual server locations are not apparent to the Web Edition 
user. 

3 Log out of the Transfer Client and log in again using your test user credentials to confirm 
that this user logs directly into the Test directory. You can browse up to the parent 
directory and confirm that this user has no view of the AdminTest directory. 

 

Add Users from Windows Active Directory 

You can use the LDAP Servers tab in the Reflection for Secure IT User Manager to provision 
users who have accounts in Windows Active Directory. This enables you to support file transfers 
by Windows domain users who are working remotely. Authentication and group membership are 
managed on the LDAP server. Each time the user logs in, current information is retrieved from 
the LDAP server. 

To provision users from an LDAP server 

1 Connect to User Manager and log in as an administrator. 

2 Click LDAP Server. 

3 Click New. 

4 Enter information for connecting to the server. For details about the LDAP settings, click 

the User Manager help button  on the New LDAP Server page. 

5 Click Test Connection to confirm that User Manager can access your LDAP server.  

Note: The Test Connection button verifies the connection but does not save your settings. 

6 Click Save. 

To view LDAP users and groups 

Note: You can view users and groups that are brought in from an LDAP server, but cannot 
modify them; these users and groups are managed on the LDAP server.  

1 Click the Users or Groups tab. 

2 Use the drop-down list to select your LDAP server. If you don't see your server, return to 
the LDAP configuration page and confirm that you saved your settings. 
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Learn More 

To learn more, visit the Reflection for Secure IT Web Edition product page 
(http://support.attachmate.com/product/?prod=RSWEB). You'll find product news, links to 
product downloads, documentation, security updates, and information about how to contact 
Attachmate technical support. 

 

 

http://support.attachmate.com/product/?prod=RSWEB�
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